PolarFire Family FPGA Custom Flow User Guide :
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I nt I'Od u CﬁOn (Ask a Question)

Libero® System-on-Chip (SoC) software provides a fully integrated Field Programmable Gate Array (FPGA)
design environment. However, a few users might want to use third-party synthesis and simulation tools
outside the Libero SoC environment. Libero can now be integrated into the FPGA design environment. It is
recommended to use Libero SoC to manage the entire FPGA design flow.

This user guide describes the Custom Flow for PolarFire® and PolarFire SoC Family devices, a process to
integrate Libero as a part of the larger FPGA design flow.

Supported Device Families
The following table lists the device families that Libero SoC supports. However, some information in this guide
might only apply to a specific family of devices. In this case, such information is clearly identified.

Table 1. Device Families Supported by Libero SoC

PolarFire® PolarFire FPGAs deliver the industry’s lowest power at mid-range densities with exceptional security and reliability.

PolarFire SoC PolarFire SoC is the first SoC FPGA with a deterministic, coherent RISC-V CPU cluster, and a deterministic L2 memory
subsystem enabling Linux® and real-time applications.


https://microchipsupport.force.com/s/newcase?pub_guid=GUID-A6A753FB-3F6D-4212-A361-9034AAF693FA&pub_lang=en-US&pub_ver=8&pub_type=User%20Guide&bu=fpga&tpc_guid=GUID-81D89143-7721-417B-9A7C-FE911F855C5E&cover_title=PolarFire%20Family%20FPGA%20Custom%20Flow%20User%20Guide&tech_support_link=NA&revision_letter=G&source=PDF&title=Introduction&devices=
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https://www.microchip.com/en-us/products/fpgas-and-plds/system-on-chip-fpgas/polarfire-soc-fpgas
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1- OVEI‘ViEW (Ask a Question)

While Libero SoC provides a fully integrated end-to-end design environment to develop SoC and
FPGA designs, it also provides the flexibility to run synthesis and simulation with third-party tools
outside the Libero SoC environment. However, some design steps must remain within the Libero

SoC environment.

The following table lists the major steps in the FPGA design flow and indicates the steps for which

Libero SoC must be used.

Table 1-1. FPGA Design Flow

Design Entry: HDL

Design Entry: Configurators

Automatic PDC/SDC constraint
generation

Simulation

Synthesis

Design Implementation: Manage
Constraints, Compile Netlist, Place-and-
Route (see Overview)

Timing and Power Verification

Configure Design Initialization Data and
Memories

Programming File Generation

No

Yes

No

No

No

Yes

Yes
Yes

Yes

Use third-party HDL editor/checker tool outside
Libero® SoC if desired.

Create first Libero project for IP catalog core
component generation.

Derived constraints need all HDL files and a
derive_constraints utility when performed outside
of Libero SoC, as described in Appendix C—Derive
Constraints.

Use third-party tool outside Libero SoC, if
desired. Requires download of pre-compiled
simulation libraries for target device, target
simulator, and target Libero version used for
backend implementation.

Use third-party tool outside Libero SoC if desired.

Create second Libero project for the backend
implementation.

Stay in second Libero project.

Use this tool to manage different types of memories
and design initialization in the device. Stay in second
project.

Stay in second project.

Important: You must download precompiled libraries available at the Pre-
Compiled Simulation Libraries page to use a third-party simulator.

In a pure Fabric FPGA flow, enter your design using HDL or schematic entry and pass that directly
to the synthesis tools. The flow is still supported. PolarFire and PolarFire SoC FPGAs have significant
proprietary hard IP blocks requiring the use of configuration cores (SgCores) from the Libero SoC IP
catalog. Special handling is required for any blocks that comprise SoC functionality:

* PolarFire
- PF_UPROM

- PF_SYSTEM_SERVICES
- PF_CCC

- PFCLK DIV

- PF_CRYPTO

- PF_DRI

- PF_INIT_MONITOR
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- PF_NGMUX

- PF_0OSC

- RAMs (TPSRAM, DPSRAM, URAM)
- PF_SRAM_AHBL_AXI
- PF_XCVR_ERM

- PF_XCVR_REF_CLK

- PF_TX_PLL

- PF_PCIE

- PF.IO

- PF_IOD_CDR

- PF_IOD_CDR_CCC

- PF_IOD_GENERIC_RX
- PF_IOD_GENERIC_TX
- PF_IOD_GENERIC_TX_CCC
- PF_RGMII_TO_GMII
- PF_IOD_OCTAL_DDR
- PF_DDR3

- PF_DDR4

- PF_LPDDR3

- PF_QDR

- PF_CORESMARTBERT
- PF_TAMPER

- PF_TVS, and so on.

In addition to the preceding listed SgCores, there are many DirectCore soft IPs available for
PolarFire and PolarFire SoC device families in the Libero SoC Catalog that use the FPGA fabric
resources.

For design entry, if you use any one of the preceding components, you must use Libero SoC
for part of the design entry (Component Configuration), but you can continue the rest of your
Design Entry (HDL entry, and so on) outside of Libero. To manage the FPGA design flow outside
of Libero, follow the steps provided in the rest of this guide.

1.1. Component Life Cycle (asaaquestion)

The following steps describe the life cycle of an SoC component and provide instructions on how to
handle the data.

1. Generate the component using its configurator in Libero SoC. This generates the following types
of data:

- HDL files

- Memory files

- Stimulus and Simulation files
- Component SDC file

2. For HDL files, instantiate and integrate them in the rest of the HDL design using the external
design entry tool/process.

3. Supply memory files and stimulus files to your simulation tool.
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4. Supply Component SDC file to Derive Constraint tool for Constraint Generation. See Appendix
C—Derive Constraints for more details.

5. You must create a second Libero project, where you import the post-Synthesis netlist and your
component metadata, thus completing the connection between what you generated and what
you program.

1.2. Libero SoC Project Creation (asa question)

Some design steps must be run inside the Libero SoC environment (Table 1-1). For these steps
to run, you must create two Libero SoC projects. The first project is used for design component
configuration and generation, and the second project is for the physical implementation of the
top-level design.

1-3- Custom FIOW (Ask a Question)
The following figure shows:

+ Libero SoC can be integrated as a part of the larger FPGA design flow with the third-party
synthesis and simulation tools outside the Libero SoC environment.

+ Various steps involved in the flow, starting from design creation and stitching all the way to
programming the device.

+ The data exchange (inputs and outputs) that must occur at each design flow step.
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Figure 1-1. Custom Flow Overview
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The following are the steps in the custom flow:

1.
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a. Create a first Libero project (to serve as a Reference Project).

b. Select the Core from the Catalog. Double click the core to give it a component name and
configure the component.
This automatically exports component data and files. A Component Manifests is also
generated. See Component Manifests for details. For more details, see Component
Configuration.

2. Complete your RTL design outside of Libero:
a. Instantiate the component HDL files.
b. The location of the HDL files is listed in the Component Manifests files.

3. Generate SDC constraints for the components. Use Derive Constraints utility to generate the
timing constraint file(SDC) based on:

a. Component HDL files
b. Component SDC files
c. User HDL files

For more details, see Appendix C—Derive Constraints.

4. Synthesis tool/simulation tool:

a. Get HDL files, stimulus files, and component data from the specific locations as noted in the
Component Manifests.

b. Synthesize and simulate the design with third-party tools outside Libero SoC.
5. Create your second (Implementation) Libero Project.

6. Remove synthesis from the design flow tool chain (Project > Project Settings > Design Flow >
clear the Enable Synthesis check box).

7. Import the design source files (post-synthesis *.vm netlist from synthesis tool):
- Import post-synthesis *.vm netlist (File>Import> Synthesized Verilog Netlist (VM)).
- Component metadata * . cfqg files for uPROM and/or sNVM.

8. Import any Libero SoC block component files. The block files must be in the * . cxz file format.
For more information on how to create a block, see PolarFire Block Flow User Guide.

9. Import the design constraints:
- Import I/0 constraint files (Constraints Manager > I/OAttributes > Import).
- Import floorplanning * . pdc files (Constraints Manager > Floor Planner > Import).

- Import *. sdc timing constraint files (Constraints Manager > Timing >Import). Import the
SDC file generated through Derive Constraint tool.
- Import *.ndc constraint files (Constraints Manager > NetlistAttributes > Import), if any.
10. Constraint file and tool association
- Inthe Constraint Manager, associate the * . pdc files to place and route, the * . sdc files to
place and route and timing verifications, and the *.ndc files to Compile Netlist.
11. Complete design implementation

- Place and route, verify timing and power, configure design initialization data and memories,
and programming file generation.

12. Validate the design

- Validate the design on FPGA and debug as necessary using the design tools provided with
the Libero SoC design suite.
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2. Component Configuration (saauestion)

The first step in the custom flow is to configure your components using a Libero reference project
(also called first Libero project in Table 1-1). In subsequent steps, you use data from this reference
project.

If you are using any components listed earlier, under the Overview in your design, perform the steps
described in this section.

If you are not using any of the above components, you can write your RTL outside of Libero

and directly import it into your Synthesis and Simulation tools. You can then proceed to the
post-synthesis section and only import your post-synthesis *.vm netlist into your final Libero
implementation project (also called second Libero project in Table 1-1).

2.1. Component Configuration Using Libero (asaauestion)
After selecting the components that must be used from the preceding list, perform the following
steps:
1. Create a new Libero project (Core Configuration and Generation): Select the Device and Family
that you target your final design to.

2. Use one or more of the cores mentioned in Custom Flow.

a. Create a SmartDesign and configure the desired core and instantiate it in the SmartDesign
component.

b. Promote all the pins to top level.
c. Generate the SmartDesign.

Double click the Simulate tool (any of Pre-Synthesis or Post-Synthesis or Post-Layout
options) to invoke the simulator. You can exit the simulator after it is invoked. This step
generates the simulation files necessary for your project.

Tip: You must perform this step if you want to simulate your design
= outside Libero.
For more information, see Simulating Your Design.

e. Save your project—this is your reference project.

2.2. Component Manifests (asa question)
When you generate your components, a set of files is generated for each component. The
Component Manifest report details the set of files generated and used in each subsequent step
(Synthesis, Simulation, Firmware Generation, and so on). This report gives you the locations of
all the generated files needed to proceed with the Custom Flow. You can access the component
manifest in the Reports area: Click Design > Reports to open the Reports tab. In the Reports
tab, you see a set of manifest. txt files (Overview), one for each component you generated.

O Tip: You must set a component or module as "root™ to see the component
= manifest file contents in the Reports tab.

Alternatively, you can access the individual manifest report files for each core component generated
or SmartDesign component from <project>/component/work/<component name>/<instance
name>/<component name> manifest.txt Or <project>/component/work/<SmartDesign
name>/<SmartDesign name> manifest.txt.You can also access the manifest file contents of
each component generated from the new Components tab in Libero, where the file locations are
mentioned with respect to the project directory.
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Figure 2-1. Accessing Component Manifest Report Files from Libero Reports Tab
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Figure 2-2. Accessing Component Manifest Report Files from Libero Components Tab

Components
Name I Core Name | Version I
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—|- HDL source files for all Synthesis and Simulation tools
component/Actel/SgCore/PF_SYSTEM_SERVICES/3.0.100/rtl/vlog/core/CoreSysServices_PF_APBS.v
component/Actel/SgCore/PF_SYSTEM_SERVICES/3.0.100/rtl/vlog/core/CoreSysServices_PF_Ctrl.v
component/Actel/SgCore/PF_SYSTEM_SERVICES/3.0.100/rtl/vlog/core/CoreSysServices_PF_RegArbiter.v
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component/Actel/SgCore/PF_SYSTEM_SERVICES/3.0.100/rtl/vlog/core/CoreSysServices PF_SSIIF.v
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= [ so1
[=] HDL source files for all Synthesis and Simulation tools
component/work/SD1/5D1.v

3 | Il
Design Flow J Design Hierarchy _I Stimulus Hierarchy _I Catalog Components I Files

Focus on the following Component Manifest reports:

+ Ifyou instantiated cores into a SmartDesign, read the file
<smartdesign name> manifest.txt.

+ If you created components for cores, read the <core component name> manifest.txt.

You must use all Component Manifests reports that apply to your design. For example, if your
project has a SmartDesign with one or more core components instantiated in it and you intend
to use them all in your final design, then you must select files listed in the Component Manifests
reports of all those components for use in your design flow.

2.3. Interpreting Manifest Files (asaquestion)

When you open a component manifest file, you see paths to files in your Libero project and pointers
on where in the design flow to use them. You might see the following types of files in a manifest file:
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« HDL source files for all Synthesis and Simulation tools

+ Stimulus files for all Simulation tools

+ Constraint files

Following is the Component Manifest of a PolarFire core component.

HDL source files for all Synthesis and Simulation tools:

D:/Designs/manifestex/component/Actel/SgCore/PF SYSTEM SERVICES/3.0.

CoreSysServices_PF_APBS.v

D:/Designs/manifestex/component/Actel/SgCore/PF SYSTEM SERVICES/3.0.

CoreSysServices PF Ctrl.v

D:/Designs/manifestex/component/Actel/SgCore/PF SYSTEM SERVICES/3.0.

CoreSysServices PF RegArbiter.v

D:/Designs/manifestex/component/Actel/SgCore/PF_SYSTEM SERVICES/3.0.

CoreSysServices PF MBXIF.v

D:/Designs/manifestex/component/Actel/SgCore/PF SYSTEM SERVICES/3.0.

CoreSysServices PF SSIIF.v

D:/Designs/manifestex/component/work/PF_SYSTEM SERVICES CO/PF _SYSTEM SERVICES CO 0/rtl/

vlog/core/PF_System Services.v

100/rtl/vlog/core/
100/rtl/vlog/core/
100/rtl/vlog/core/
100/rtl/vlog/core/

100/rtl/vlog/core/

D:/Designs/manifestex/component/work/PF_SYSTEM SERVICES_ CO/PF_SYSTEM SERVICES CO.v

Each type of file is necessary downstream in your design flow. The following sections describe

integration of the files from the manifest into your design flow.
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Constraint Generation (s question)

When performing configuration and generation, ensure to write/generate the SDC/PDC/NDC
constraint files for the design to pass them to Synthesis, Place-and-Route, and Verify Timing tools.

Use the Derive Constraints utility outside of the Libero environment to generate constraints instead
of writing them manually. To use the Derive Constraint utility outside of the Libero environment, you
must:

«  Supply user HDL, component HDL, and component SDC constraint files
+ Specify the top level module
+ Specify the location where to generate the derived constraint files

The SDC component constraints are available under <project>/component/work/<component
name>/<instance name>/ directory after component configuration and generation.

For more details on how to generate constraints for your design, see Appendix C—Derive
Constraints.
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4. Synthesizing Your Design (asa auestion)

One of the primary features of the Custom Flow is to allow you to use a third-party synthesis
tool outside Libero. The custom flow supports the use of Synopsys SynplifyPro. To synthesize your
project, use the following procedure:

1. Create a new project in your Synthesis tool, targeting the same device family, die, and package
as the Libero project you created.
a. Import your own RTL files as you normally do.

b. Setthe Synthesis output to be Structural Verilog (. vm).

Tip: Structural Verilog (.vm) is the only supported synthesis output format in
= PolarFire.

2. Import Component HDL files into your Synthesis project:

a. For each Component Manifests Report: For each file under HDL source files for all
Synthesis and Simulation tools, import the file into your Synthesis Project.

3. Importthefile polarfire syn comps.v (if using Synopsys Synplify) from <Libero
Installation location>/data/aPA5SM to your Synthesis project.

4. Import the previously generated SDC file through the Derived Constraint tool (see Appendix
A—Sample SDC Constraints) into the Synthesis tool. This constraint file constrains the synthesis
tool to achieve timing closure with less effort and fewer design iterations.

Important:

+ Ifyou plan to use the same *. sdc file to constrain Place-and-Route during the
design implementation phase, you must import this * . sdc into the synthesis
project. This is to ensure that there are no design object name mismatches
in the synthesized netlist and the Place-and-Route constraints during the
implementation phase of the design process. If you do not include this * . sdc
file in the Synthesis step, the netlist generated from Synthesis may fail the
Place and Route step because of design object name mismatches.

a. Import Netlist Attributes * . ndc, if any, into the Synthesis tool.
b. Run Synthesis.

+ The location of your Synthesis tool output has the * . vm netlist file generated
post Synthesis. You must import the netlist into the Libero Implementation
Project to continue with the design process.
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5. Simulating Your Design sa question)
To simulate your design outside of Libero (that is, using your own simulation environment and
simulator), perform the following steps:
1. Design Files:
a. Pre-Synthesis simulation:
+ Import your RTL into your simulation project.
+ For each Component Manifests Report.
- Import each file under HDL source files for all Synthesis and Simulation tools
into your simulation project.
+ Compile these files as per your simulator's instructions.

b. Post-synthesis simulation:

+ Import your post-synthesis *.vm netlist (generated in Synthesizing Your Design) into
your simulation project and compile it.

c. Post-layout simulation:

+ First, complete implementing your design (see Implementing Your Design). Ensure that
your final Libero project is in post-layout state.

* Double-click Generate BackAnnotated Files inthe Libero Design Flow window. It
generates two files:

<project directory>/designer/<root>/<root> ba.v/vhd <project directory>/designer/
<root>/<root> ba.sdf

+ Import both of these files into your simulation tool.
2. Stimulus and Configuration files:
a. For each Component Manifests Report:

+ Copy all files under the Sstimulus Files for all Simulation Tools sections to
the root directory of your Simulation project.

b. Ensure that any Tcl files in the preceding lists (in step 2.a) are executed first, before the start
of simulation.

C. UPROM.mem: If you use the UPROM core in your design with the option Use content for
simulation enabled for one or more data storage clients that you wish to simulate, you must
use the executable pa4rtupromgen (pad4rtupromgen.exe on windows)to generate the
UPROM.men file. The pa4rtupromgen executable takes the UPROM. cfq file as inputs through
a Tcl script file and outputs the UPROM. mem file required for simulations. This UPROM. mem file
must be copied to the simulation folder prior to the simulation run. An example showing
the padrtupromgen executable usage is provided in the following steps. The UPROM. cfg
file is available in the directory <Project>/component/work/<uPROM component name>/
<uPROM instance name> inthe Libero project that you used to generate the UPROM
component.

d. snvm.mem: If you use the System Services core in your design and configured the
sNVM tab in the core with the option Use content for simulation enabled for one or
more clients that you wish to simulate, a snvm.mem file is automatically generated to
the directory <Project>/component/work/<PolarFire System Services component
name>/<uPROM instance name> inthe Libero project that you used to generate the
System Services component. This snvm.memn file must be copied to the simulation folder
prior to the simulation run.

3. Create a working folder and a sub-folder named simulation under the working folder.
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The pa4rtupromgen executable expect the presence of the simulation sub folder in the
working folder and the *. tc1 script is placed in the simulation sub folder.

Copy the UPROM. cfg file from the first Libero project created for component generation into the
working folder.

Paste the following commands in a *. tcl script and place it in the simulation folder created in
step 3.

Sample *.tcl for PolarFire and PolarFire Soc Family devices to generate URPOM.mem file
from UPROM.cfg

set device -fam <family> -die <internal die name> -pkg <internal pkg name>

set input cfg -path <path to UPROM.cfg>

set sim mem -path <path to UPROM Initialization File/UPROM.mem>

gen_sim -use init false

For the proper internal name to use for the die and package, see the *.pr7jx file of the first
Libero project (used for component generation).

The argument use _init must be set to false.

Use the set _sim mem command to specify the path to the output file UPROM.mem that is
generated upon execution of the script file with the pa4rtupromgen executable.

At the command prompt or cygwin terminal, go to the working directory created in step 3.
Execute the pa4rtupromgen command with the--script option and pass to it the *. tc1 script
created in the previous step.

For Windows®:

<Libero SoC release installation>/designer/bin/padrtupromgen.exe \
--script./simulation/<Tcl script name>.tcl

. ®
For Linux :

<Libero_SoC_release_ installation>/bin/padrtupromgen
--script./simulation/<tcl_script name>.tcl

After successful execution of the pa4rtupromgen executable, check that the UPROM. men file is
generated in the location specified in the set sim mem command in the * . tc1l script.

To simulate the sSNVM, copy the snvm.mem file from your first Libero project (used for
component configuration) into the top level simulation folder of your simulation project to run
simulation (outside of Libero SoC). To simulate UPROM contents, copy the generated UPROM.mem
file into the top level simulation folder of your simulation project to run simulation (outside of
Libero SoC).

Important: To simulate the functionality of SoC Components, download the pre-
compiled PolarFire simulation libraries and import them into your simulation
environment as described here. For more details, see Appendix B—Importing
Simulation Libraries into Simulation Environment.
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6. Implementing Your Design (asa question)
After completing the Synthesis and Post-Synthesis simulation in your environment, you must use
Libero again to physically implement your design, run timing and power analysis, and generate your
programming file.
1. Create a new Libero project for the physical implementation and layout of the design. Ensure to
target the same device as in the reference project you created in Component Configuration.

2. After project creation, remove Synthesis from the tool chain in the Design Flow window
(Project > Project Settings > Design Flow > Uncheck Enable Synthesis).

3. Import your post-synthesis *.vm file into this project, (File > Import > Synthesized
Verilog Netlist (VM)).

a.

O Tip: Itis recommended that you create a link to this file, so that if you re-

synthesize your design, Libero always uses the latest post-synthesis netlist.

In the Design Hierarchy window, note the name of the root module.

Figure 6-1. Root Module in Design Hierarchy

Dresign Hierarchy n
Top Module(root): top

Build Hieran:hy| | @, show: [comporents ~| B B ? &
- il work

E| top (topym) [work]

4. Import the constraints into the Libero project. Use the Constraint Manager to import * . pdc/
*_sdc/*.ndc constraints.

a.

Import I/O *.pdc constraint files (Constraints Manager > I/0 Attributes >
Import).

Import Floorplanning * .pdc constraint files (Constraints Manager > Floor Planner >
Import) .

Import *. sdc timing constraint files (Constraints Manager > Timing > Import).If
your design has any of the cores listed in Overview, ensure to import the SDC file generated
through derive constraint tool.

Import * . ndc constraint files (Constraints Manager > Netlist Attributes >
Import).

5. Associate Constraints Files to design tools.
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a. Open Constraint Manager (Manage Constraints > Open Manage Constraints View).
Check the Place-and-Route and Timing Verification check box next to the constraint file
to establish constraint file and tool association. Associate the * . pdc constraint to Place-and-
Route and the *. sdc to both Place-and-Route and Timing Verification. Associate the *.ndc
file to Compile Netlist.

Tip: If Place and Route fails with this * . sdc constraint file, then import this
= same *.sdc file to synthesis and re-run synthesis.

6. Click Compile Netlist and then Place and Route to complete the layout step.

7. The Configure Design Initialization Data and Memories tool allows you to initialize design blocks,
such as LSRAM, uSRAM, XCVR (transceivers), and PCle using data stored in nonvolatile yPROM,
sNVM, or external SPI Flash storage memory. The tool has the following tabs for defining the
specification of the design initialization sequence, the specification of the initialization clients,
user data clients.

- Design Initialization tab
HPROM tab

sNVM tab

SPI Flash tab

Fabric RAMs tab

Use the tabs in the tool to configure the design initialization data and memories.

Figure 6-2. Design Initialization Data and Memories
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4. Generate or export the bibstream

5. Program the device
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After completing the configuration, perform the following steps to program the initialization
data:

+ Generate initialization clients
+ Generate or export the bitstream
* Program the device

For detailed information on how to use this tool, see Libero SoC Design Flow User Guide. For
more information on the Tcl commands used to configure various tabs in the tool and specify
memory configuration files (* . cfg), see Tcl Commands Reference Guide.

8. Generate a Programming File from this project and use it to program your FPGA.
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7. Appendix A—Sample SDC Constraints aauestion)

Libero SoC generates SDC timing constraints for certain IP cores, such as CCC, OSC, Transceiver and
so on. Passing the SDC constraints to design tools increases the chance of meeting timing closure
with less effort and fewer design iterations. The full hierarchical path from the top-level instance is
given for all design objects referenced in the constraints.

7.1. SDC Timing Constraints (asa question)

In the Libero IP core reference project, this top-level SDC constraint file is available from the
Constraint Manager (Design Flow > Open Manage Constraint View >Timing > Derive
Constraints).

Important: See this file to set the SDC constraints if your design contains CCC,
OSC, Transceiver, and other components. Modify the full hierarchical path, if
necessary, to match your design hierarchy or use the Derive_Constraints utility
and steps in Appendix C—Derive Constraints on the component level SDC file.
Save the file to a different name and import the SDC file to the synthesis tool,
Place-and-Route Tool, and Timing Verifications, just like any other SDC constraint
files.

7.1.1. Derived SDC File (Ask a Question)

# This file was generated based on the following SDC source files:

# /drive/icicle kit ref des/icicle-kit-reference-design-master/MPFS ICICLE/component/work/
PF_CCC_CO/PF_CCC CO O/PF CCC_CO_PF CCC CO 0 PF CCC.sdc

# /drive/icicle kit ref des/icicle-kit-reference-design-master/MPFS_ ICICLE/component/work/
CLK DIV/CLK DIV 0/CLK DIV CLK DIV 0 PF CLK DIV.sdc

# /drive/icicle kit ref des/icicle-kit-reference-design-master/MPFS ICICLE/component/work/
TRANSMIT PLL/TRANSMIT PLL 0/TRANSMIT PLL TRANSMIT PLL 0 PF TX PLL.sdc

# /drive/icicle kit ref des/icicle-kit-reference-design-master/MPFS_ICICLE/component/work/
DMA INITIATOR/DMA INITIATOR O/DMA INITIATOR.sdc

# /drive/icicle kit ref des/icicle-kit-reference-design-master/MPFS_ICICLE/component/work/
FICO INITIATOR/FICO INITIATOR 0/FICO INITIATOR.sdc

# /drive/icicle kit ref des/icicle-kit-reference-design-master/MPFS ICICLE/component/work/
ICICLE MSS/ICICLE MSS.sdc

# /drive/icicle kit ref des/icicle-kit-reference-design-master/MPFS_ICICLE/component/work/
PF PCIE CO/PF PCIE CO O/PF PCIE CO PF PCIE CO 0O PF PCIE.sdc

# /drive/icicle kit ref des/icicle-kit-reference-design-master/MPFS_ICICLE/component/work/
PCIE INITIATOR/PCIE INITIATOR 0/PCIE INITIATOR.sdc

# /drive/aPASM/cores/constraints/osc_rcl60mhz.sdc

# *** Any modifications to this file will be lost if derived constraints is re-run. ***
create_clock -name {CLOCKS_AND RESETS inst 0/OSCILLATOR 160MHz_inst 0/OSCILLATOR_160MHz_0/
I O0SC_160/CLK} -period 6.25

[ get pins { CLOCKS AND RESETS inst O/OSCILLATOR 160MHz_inst O/OSCILLATOR 160MHz 0/

I 0SC_160/CLK } 1

create clock -name {REF_CLK PAD P} -period 10 [ get ports { REF CLK PAD P } ]

create clock -name {CLOCKS AND RESETS inst 0/TRANSMIT PLL O/TRANSMIT PLL _ 0/txpll isnt 0/
DIV CLK} -period 8

[ get pins { CLOCKS AND RESETS inst 0/TRANSMIT PLL O/TRANSMIT PLL O/txpll isnt O/DIV CLK } ]
create generated clock -name {CLOCKS AND RESETS inst 0/CCC_FIC x CLK/PF _CCC_CO_0/pll inst 0/
OUTO} -multiply by 25 -divide by 32 -source

[ get pins { CLOCKS AND RESETS inst 0/CCC_FIC x CLK/PF CCC _CO 0/pll inst O/REF CLK 0 } ]
-phase 0

[ get_pins { CLOCKS_AND RESETS inst 0/CCC_FIC_x CLK/PF_CCC_CO_0/pll_inst_0/OUTO } ]

create generated clock -name {CLOCKS AND RESETS inst 0/CCC_FIC x CLK/PF _CCC _CO_0/pll inst 0/
OUT1} -multiply by 25 -divide by 32 -source

[ get_pins { CLOCKS_AND RESETS inst 0/CCC_FIC_x CLK/PF_CCC_CO_0/pll_inst O/REF_CLK 0 } ]
-phase 0

[ get pins { CLOCKS AND RESETS inst 0/CCC FIC x CLK/PF CCC CO 0/pll inst 0/0UT1 } ]
create_generated clock -name {CLOCKS_AND RESETS_ inst_0/CCC_FIC_x CLK/PF_CCC_CO_0/pll_inst 0/
OUT2} -multiply by 25 -divide by 32 -source

[ get pins { CLOCKS AND RESETS inst 0/CCC FIC x CLK/PF CCC CO 0/pll inst O/REF CLK 0 } ]
-phase 0

[ get pins { CLOCKS_AND RESETS inst 0/CCC_FIC x CLK/PF CCC _CO 0/pll inst 0/0UT2 } ]
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create generated clock -name {CLOCKS AND RESETS inst 0/CCC_FIC x CLK/PF_CCC CO 0/pll inst 0/
OUT3} -multiply by 25 -divide by 64 -source

[ get pins { CLOCKS AND RESETS inst 0/CCC FIC x CLK/PF CCC CO 0/pll inst O/REF CLK 0 } ]
-phase 0

[ get pins { CLOCKS AND RESETS inst 0/CCC FIC x CLK/PF CCC CO 0/pll inst 0/OUT3 } ]

create generated clock -name {CLOCKS_AND RESETS_ inst_ 0/CLK_160MHz_to CLK_80MHz/CLK DIV_0/I_CD/
Y DIV} -divide by 2 -source

[ get plns { CLOCKS AND RESETS__ inst 0/CLK 160MHz _to CLK 80MHz/CLK DIV 0/I CD/A } ]

[ get pins { CLOCKS “AND RESETS inst O/CLK 160MHz to CLK 80MHz/CLK DIV 0/I CD/Y DIV } ]

set false path —through [ get nets { DMA INITIATOR inst O/ARESETN* } ]

set false path -from [ get cells { DMA INITIATOR inst O/*/Svaonvertor _loop[*].slvcnv/slvCDC/
genblkl*/rdGrayCounter*/cntGray* } ]

-to [ get_cells { DMA INITIATOR inst 0/*/SlvConvertor loop[*].slvcnv/slvCDC/genblkl*/

rdPtr sl* } ]

set false _path -from [ get cells { DMA INITIATOR inst 0/*/SlvConvertor loop[*].slvcnv/slvCDC/
genblkl*/wrGrayCounter*/cntGray* } ]

-to [ get cells { DMA INITIATOR inst 0/*/SlvConvertor loop[*].slvcnv/slvCDC/genblkl*/

wrPtr sl* } ]

set_false path -through [ get nets { FICO_INITIATOR inst O/ARESETN* } ]

set false path -to [ get pins { PCIE/PF PCIE CO 0/PCIE 1/INTERRUPT[0] PCIE/PF _PCIE CO 0/

PCIE l/INTERRUPT[l] PCIE/PF PCIE CO 0/PCIE l/INTERRUPT[Z] PCIE/PF PCIE CO 0/PCIE 1/
INTERRUPT[3] PCIE/PF PCIE co O/PCIE 1/INTERRUPT[4] PCIE/PF PCIE co O/PCIE l/INTERRUPT[S]
PCIE/PF PCIE CO O/PCIE 1/INTERRUPT[6] PCIE/PF PCIE CO O/PCIE 1/INTERRUPT[7] PCIE/PF_PCIE_CO_O/
PCIE l/WAKEREQ PCIE/PF PCIE CO O/PCIE 1/MPERST N } ]

setifalseipath -from [ get pins { PCIE/PF PCIE CO O/PCIE 1/TL CLK } ]

set_false path -through [ get nets { PCIE_ INITIATOR inst O/ARESETN* } ]
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Appendix B—Importing Simulation Libraries into Simulation
Environment sz auestion)

The default simulator for RTL simulation with Libero SoC is QuestaSim® Pro ME. Pre-
compiled libraries for default simulator are available with Libero installation at directory
<install location>/Designer/lib/questasim/precompiled/vlog for supported families.

Libero SoC also supports other third-party simulators editions of ModelSim, VCS, Xcelium™, Active
HDL, and Riviera Pro. Download respective pre-compiled libraries from the Pre-Compiled Simulation
Libraries page based on the simulator and its version.

Similar to Libero environment, run.do file must be created to run simulation outside Libero.
Create a simple run. do file that has commands to establish library for compilation results, library
mapping, compilation, and simulation. Follow the steps to create a basic run.do file.
1. Create a logical library to store compilation results using v1ib command

vlib presynth.

2. Map the logical library name to pre-compiled library directory using vmap command vmap
<logical name> <pre-compiled directory path>.

3. Compile source files—use language-specific compiler commands to compile design files into
working directory.

- vlogfor .v/.sv
- vcomfor .vhd

4. Load the design for simulation using vsim command by specifying name of any top-level
module.

5. Simulate the design using run command.

After loading the design, simulation time is set to zero, and you can enter the run command to begin
simulation.

In the simulator transcript window, execute run.do file as run.do run the simulation. Sample
run.do file as follows.

quietly set ACTELLIBNAME PolarFire

quietly set PROJECT DIR "W:/Test/basic test"

if {[file exists presynth/ infol} { eChO "INFO: Simulatior ibrary presynth exists" }
else { file delete -force presynth vlib presynth }

vmap presynth presynth

vmap PolarFire "X:/Libero/LC gner/lib/questasim/precompiled/vlog/PolarFire"
vlog -sv -work presynth " JECT DIR}/hdl/top.v"
vlog "+incdir+${PROJECT DIR}/stinm \\\“ -sv -work presynth "${PROJEC IR} /stimu s/tb.v"

vsim -L PolarFlre -L presynth -t lps presynth.tb add wave /tb/* run 1000ns log /tb/*
exit
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9. Appendix C—Derive Constraints sa queston)
This appendix describes the Derive Constraints Tcl commands.

9.1. Derive Constraints Tcl Commands (aska question)

The derive constraints utility helps you derive constraints from the RTL or the configurator
outside the Libero SoC design environment. To generate constraints for your design, you need

the User HDL, Component HDL, and Component Constraints files. The SDC component constraints
files are available under <project>/component/work/<component name>/<instance name>/
directory after component configuration and generation.

Each component constraint file consists of the set component tcl command (specifies the
component name) and the list of constraints generated after configuration. The constraints are
generated based on the configuration and are specific to each component.

Example 9-1. Component Constraint File for the PF_CCC Core

Here is an example of a component constraint file for the PF_CCC core:

set component PF CCC CO PF CCC CO 0 PF CCC

# Microchip Corp.

# Date: 2021-Oct-26 04:36:00

# Base clock for PLL #0

create clock -period 10 [ get pins { pll inst O/REF CLK 0 } ]

create generated clock -divide by 1 -source [ get pins { pll inst 0/
REF CLK 0 } ]

-phase 0 [ get pins { pll inst 0/0UTO } ]

Here, create clock and create generated clock are reference and output
clock constraints respectively, which are generated based on the configuration.

9.1.1. Working with derive_constraints Utility (aska question)

Derive constraints traverse through the design and allocate new constraints for each instance of
component based on previously provided component SDC files. For the CCC reference clocks, it
propagates back through the design to find the source of the reference clock. If the source is an I/0,
the reference clock constraint will be set on the I/0. If it is a CCC output or another clock source (for
example, Transceiver, oscillator), it uses the clock from the other component and reports a warning
if the intervals do not match. Derive constraints will also allocate constraints for some macros like
on-chip oscillators if you have them in your RTL.

To execute the derive constraints utility, you must supply a . tcl file command-line argument
with the following information in the specified order.

Specify device information using the information in section set_device.

Specify path to the RTL files using the information in section read_verilog or read_vhdl.

Set top level module using the information in section set_top_level.

Specify path to the component SDC files using the information in section read_sdc or read_ndc.
Execute the files using the information in section derive_constraints.

o v kA W=

Specify path to the SDC derived constraints file using the information in section write_sdc or
write_pdc or write_ndc.
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9.1.2.

Example 9-2. Execution and Contents of the derive. tcl File

The following is an example command-line argument to execute the
derive constraints utility.

$ <libero_installation path>/bin{64}/derive constraints derive.tcl
The contents of the derive.tcl file:

# Device information

set device -family PolarFire -die MPF100T -speed -1

# RTL files

read verilog -mode system verilog project/component/work/txpll0/

txpll0 txpll0 0 PF TX PLL.v

read verilog -mode system verilog {project/component/work/txpll0/txpll0.v}
read verilog -mode system verilog {project/component/work/xcvr0/I XCVR/
xcvr0 I XCVR_PF XCVR.v}

read verilog -mode system verilog {project/component/work/xcvr0/xcvr0.v}
read vhdl -mode vhdl 2008 {project/hdl/xcvrl.vhd}

#Component SDC files

set top level {xcvrl}

read sdc -component {project/component/work/txpll0/txpll0 0/
txpll0_txpll0_O0_PF TX PLL.sdc}

read sdc -component {project/component/work/xcvr0/I_ XCVR/
xcvr0_I XCVR PF XCVR.sdc}

#Use derive constraint command

derive constraints

#SDC/PDC/NDC result files

write sdc {project/constraint/xcvrl derived constraints.sdc}

write pdc {project/constraint/fp/xcvrl derived constraints.pdc}

Set_dEVice (Ask a Question)

Description
Specify family name, die name, and speed grade.

set device -family <family name> -die <die name> -speed <speed>

Arguments
-family <family_name> String Specify the family name. Possible values are PolarFire®, PolarFire SoC.
-die <die_name> String Specify the die name.
-speed <speed> String Specify the device speed grade. Possible values are STD or -1.
0 Command succeeded.
1 Command failed. There is an error. You can observe the error message in the

console.

List of Errors
ERR0023  Required parameter—die is missing  The die option is mandatory and must be specified.

ERRO005  Unknown die 'MPF30' The value of -die option is not correct. See the possible list of values in
option's description.

ERRO023  Parameter—die is missing value The die option is specified without value.

ERR0023  Required parameter—family is missing The family option is mandatory and must be specified.
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9.1.3.

set_device (continued)

ERR0004 ' The family option is not correct. See the possible list of values in

Unknown family 'PolarFire® - O]
option's description.

ERR0023  Parameter—family is missing value The family option is specified without value.

ERRO023  Required parameter—speed is missing The speed option is mandatory and must be specified.

ERR0O007  Unknown speed '<speed>' The speed option is not correct. See the possible list of values in
option's description.
ERR0023  Parameter—speed is missing value The speed option is specified without value.
Example

set_device -family {PolarFire} -die {MPF300T_ES} -speed -1

set device -family SmartFusion 2 -die M2S090T -speed -1

read_verilog (aska question)

Description
Read a Verilog file using Verific.

read verilog [-1lib <libname>] [-mode <mode>] <filename>
Arguments
-lib <libname> String Specify the library that contains the modules to be added into the
library.
-mode <mode> String Specify the Verilog standard. Possible values

areverilog 95, verilog 2k, system verilog 2005,

system verilog 2009, system verilog, verilog ams,
verilog psl, system verilog mfcu. Values are case insensitive.
Defaultis verilog 2k.

filename String Verilog file name.

0 Command succeeded.

1 Command failed. There is an error. You can observe the error message in the
console.

List of Errors

ERR0023  Parameter—Iib is missing value The lib option is specified without value.

ERR0023  Parameter—mode is missing value The mode option is specified without value.

ERRO015  Unknown mode '<mode>' The specified verilog mode is unknown. See the list of possible verilog

mode in—mode option description.

ERR0023  Required parameter file name is No verilog file path is provided.
missing

ERRO016  Failed due to Verific's Syntax error in verilog file. Verific's parser can be observed in the
parser console above the error message.

ERRO012  set_device is not called The device information is not specified. Use set device command to

describe the device.
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Example

read verilog -mode system verilog {component/work/top/top.v}

read verilog -mode system verilog mfcu design.v

9.1.4. read_VhdI (Ask a Question)

Description
Add a VHDL file into the list of VHDL files.

read vhdl [-1lib <libname>] [-mode <mode>] <filename>
Arguments

-lib <libname> — Specify the library in which the content must be added.

-mode <mode> — Specifies the VHDL standard. Default is VHDL_93. Possible values
are vhdl_93, vhdl_87, vhdl_2k, vhdl_2008, vhdl_psl. Values are case
insensitive.

filename — VHDL file name.

0
1

Command succeeded.

Command failed. There is an error. You can observe the error message in the
console.

List of Errors

ERR0023
ERR0023
ERRO018

ERR0023
ERRO019

ERRO012

Example

Parameter—lib is missing value The lib option is specified without value.
Parameter—mode is missing value The mode option is specified without value.
Unknown mode '<mode>' The specified VHDL mode is unknown. See the list of possible VHDL

mode in—mode option description.

Required parameter file name is missing No VHDL file path is provided.

Unable to register invalid path.v file The specified VHDL file does not exist or does not have read
permissions.

set_device is not called The device information is not specified. Use set _device command to
describe the device.

read_vhdl -mode vhdl 2008 osc2dfn.vhd

read vhdl {hdl/top.vhd}

9.1.5. Set_top_level (Ask a Question)

Description
Specify the name of the top-level module in RTL.

set top level [-lib <libname>] <name>
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9.1.6.

Arguments

-lib <libname> String The library to search for the top-level module or entity (Optional).

name String The top-level module or entity name.

0 Command succeeded.

1 Command failed. There is an error. You can observe the error message in the
console.

List of Errors

ERR0023  Required parameter top level is The top level option is mandatory and must be specified.
missing
ERR0023  Parameter—Ilib is missing value The lib option is specified without values.
ERRO014  Unable to find top level <top>in The specified top-level module is not defined in the provided library. To
library <lib> fix this error, the top module or library name must be corrected.
ERRO017  Elaborate failed Error in RTL elaboration process. The error message can be observed

from the console.

Example

set top level {top}
set_top_level -1ib hdl top

read_SdC (Ask a Question)

Description
Read a SDC file into the component database.

read sdc -component <filename>

Arguments
-component — This is a mandatory flag for read_sdc command when we derive
constraints.
filename String Path to the SDC file.
0 Command succeeded.
1 Command failed. There is an error. You can observe the error message in the

console.

List of Errors

ERR0023  Required parameter file name is The mandatory option file name is not specified.
missing.

ERRO000  SDC file <file_path> is not readable.  The specified SDC file does not have read permissions.
ERRO00T  Unable to open <file_path> file. The SDC file does not exist. The path must be corrected.

ERROO08  Missing set component command  The specified component of SDC file does not specify the component.
in <file_path> file
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read_sdc (continued)

ERRO009  <List of errors from sdc file> The SDC file contains incorrect sdc commands. For example,
when there is an error in set_multicycle path constraint: Error
while executing command read_sdc: in <sdc_file path> file:
Eﬂorinconwnandsetimulticycleipath: Unknown parameter
[get cells {reg all].

Example

read_sdc -component {./component/work/ccc0/ccc0_0/cccO_cccO_0_PF_CCC.sdc}

9.1.7. read_ndc (Ask a Question)

Description
Read an NDC file into the component database.

read_ndc -component <filename>

Arguments
-component — This is a mandatory flag for read _ndc command when we derive
constraints.
filename String Path to the NDC file.
0 Command succeeded.
1 Command failed. There is an error. You can observe the error message in the

console.

List of Errors

ERRO001 Unable to open <file_path> file The NDC file does not exist. The path must be corrected.

ERR0023 Required parameter—AtclParamO_ is missing. The mandatory option filename is not specified.

ERR0023 Required parameter—component is missing. Component option is mandatory and must be specified.
ERR0000 NDC file '<file_path>'is not readable. The specified NDC file does not have read permissions.
Example

read ndc -component {component/work/cccl/cccl 0/ccc_comp.ndc}

9.1.8. derive_constraints (aska question)

Description
Instantiate component SDC files into the design-level database.

derive constraints

Arguments
0 Command succeeded.
1 Command failed. There is an error. You can observe the error message in the

console.
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List of Errors

ERRO013  Top-level is not defined This means that the top-level module or entity is not specified. To fix this call, issue the
set_top_level command before the derive constraints command.

Example

derive constraints

9.1.9. Write_SdC (Ask a Question)

Description
Writes a constraint file in SDC format.

write sdc <filename>

Arguments
<filename> String Path to the SDC file will be generated. This is a mandatory option.

If the file exists, it will be overwritten.

0 Command succeeded.
1 Command failed. There is an error. You can observe the error message in the
console.

List of Errors

ERRO003  Unable to open <file path> file. File path is not correct. Check whether the parent directories exist.
ERR0002  SDC file '<file path>'is not writable. The specified SDC file does not have write permission.

ERRO023  Required parameter file name is missing. The SDC file path is a mandatory option and must be specified.

Example

write sdc "derived.sdc"

9.1.10. Write_pdc (Ask a Question)

Description
Writes physical constraints (Derive Constraints only).

write pdc <filename>

Arguments
<filename> String Path to the PDC file will be generated. This is a mandatory option.

If the file path exists, it will be overwritten.

0 Command succeeded.
1 Command failed. There is an error. You can observe the error message in the
console.
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9.1.11.

9.1.12.

List of Errors

ERRO003  Unable to open <file path> file The file path is not correct. Check whether the parent directories exist.
ERR0002  PDC file '<file path>'is not writeable. The specified PDC file does not have write permission.

ERR0023  Required parameter file name is missing The PDC file path is a mandatory option and must be specified.

Example

write pdc "derived.pdc"

Write_ndc (Ask a Question)

Description
Writes NDC constraints into a file.

write ndc <filename>

Arguments
filename String Path to the NDC file will be generated. This is a mandatory option. If

the file exists, it will be overwritten.

0 Command succeeded.
1 Command failed. There is an error. You can observe the error message in the
console.

List of Errors

ERRO003  Unable to open <file_path> file. File path is not correct. The parent directories do not exist.
ERR0002  NDC file '<file_path>'is not writable. The specified NDC file does not have write permission.

ERR0023  Required parameter _AtclParamO_is missing. The NDC file path is a mandatory option and must be specified.

Example

write ndc "derived.ndc"

add_inCIUde_path (Ask a Question)

Description
Specifies a path to search include files when reading RTL files.

add_include path <directory>

Arguments
directory String Specifies a path to search include files when reading RTL files. This

option is mandatory.

0 Command succeeded.
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add_include_path (continued)

1 Command failed. There is an error. You can observe the error message in the
console.

List of Errors

ERR0023 Required parameter include path is missing. The directory option is mandatory and must be provided.

Note: If the directory path is not correct, then add_include_path will be passed without an error.
However, read verilog/read vhd commands will fail due to Verific's parser.

Example

add _include path component/work/COREABCO/COREABCO 0/rtl/vlog/core
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10. Revision History s aueston)

The revision history describes the changes that were implemented in the document. The changes
are listed by revision, starting with the most current publication.

G 05/2025 This document is released with Libero SoC Design Suite v2025.1 without
changes from v2024.2.

F 08/2024 The following changes are made in this revision:
+ Updated section Appendix B—Importing Simulation Libraries into
Simulation Environment.
E 08/2024 The following changes are made in this revision:
+ Updated section Overview.
+ Updated section Derived SDC File.
+ Updated section Appendix B—Importing Simulation Libraries into
Simulation Environment.

D 02/2024 This document is released with Libero 2024.1 SoC Design Suite without
changes from v2023.2.
Updated section Working with derive_constraints Utility

C 08/2023 This document is released with Libero 2023.2 SoC Design Suite without
changes from v2023.1.

B 04/2023 This document is released with Libero 2023.1 SoC Design Suite without
changes from v2022.3.

A 12/2022 Initial Revision.
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Microchip FPGA Support

Microchip FPGA products group backs its products with various support services, including
Customer Service, Customer Technical Support Center, a website, and worldwide sales offices.
Customers are suggested to visit Microchip online resources prior to contacting support as it is
very likely that their queries have been already answered.

Contact Technical Support Center through the website at www.microchip.com/support. Mention the
FPGA Device Part number, select appropriate case category, and upload design files while creating a
technical support case.

Contact Customer Service for non-technical product support, such as product pricing, product
upgrades, update information, order status, and authorization.

*  From North America, call 800.262.1060
*  From the rest of the world, call 650.318.4460
+ Fax, from anywhere in the world, 650.318.8044

Microchip Information

Trademarks

The “Microchip” name and logo, the “M” logo, and other names, logos, and brands are registered
and unregistered trademarks of Microchip Technology Incorporated or its affiliates and/or
subsidiaries in the United States and/or other countries (“Microchip Trademarks"). Information
regarding Microchip Trademarks can be found at https://www.microchip.com/en-us/about/legal-
information/microchip-trademarks.

ISBN: 979-8-3371-1123-0

Legal Notice

This publication and the information herein may be used only with Microchip products, including

to design, test, and integrate Microchip products with your application. Use of this information

in any other manner violates these terms. Information regarding device applications is provided
only for your convenience and may be superseded by updates. It is your responsibility to ensure
that your application meets with your specifications. Contact your local Microchip sales office for
additional support or, obtain additional support at www.microchip.com/en-us/support/design-help/
client-support-services.

THIS INFORMATION IS PROVIDED BY MICROCHIP “AS IS”. MICROCHIP MAKES NO REPRESENTATIONS
OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY

OR OTHERWISE, RELATED TO THE INFORMATION INCLUDING BUT NOT LIMITED TO ANY IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY, AND FITNESS FOR A PARTICULAR
PURPOSE, OR WARRANTIES RELATED TO ITS CONDITION, QUALITY, OR PERFORMANCE.

IN NO EVENT WILL MICROCHIP BE LIABLE FOR ANY INDIRECT, SPECIAL, PUNITIVE, INCIDENTAL, OR
CONSEQUENTIAL LOSS, DAMAGE, COST, OR EXPENSE OF ANY KIND WHATSOEVER RELATED TO THE
INFORMATION OR ITS USE, HOWEVER CAUSED, EVEN IF MICROCHIP HAS BEEN ADVISED OF THE
POSSIBILITY OR THE DAMAGES ARE FORESEEABLE. TO THE FULLEST EXTENT ALLOWED BY LAW,
MICROCHIP'S TOTAL LIABILITY ON ALL CLAIMS IN ANY WAY RELATED TO THE INFORMATION OR

ITS USE WILL NOT EXCEED THE AMOUNT OF FEES, IF ANY, THAT YOU HAVE PAID DIRECTLY TO
MICROCHIP FOR THE INFORMATION.

Use of Microchip devices in life support and/or safety applications is entirely at the buyer’s risk,

and the buyer agrees to defend, indemnify and hold harmless Microchip from any and all damages,
claims, suits, or expenses resulting from such use. No licenses are conveyed, implicitly or otherwise,
under any Microchip intellectual property rights unless otherwise stated.

@ MICROCHIP

31


http://www.microchip.com/support
https://www.microchip.com/en-us/about/legal-information/microchip-trademarks
https://www.microchip.com/en-us/about/legal-information/microchip-trademarks
https://www.microchip.com/en-us/support/design-help/client-support-services
https://www.microchip.com/en-us/support/design-help/client-support-services

Microchip Devices Code Protection Feature
Note the following details of the code protection feature on Microchip products:

* Microchip products meet the specifications contained in their particular Microchip Data Sheet.

+ Microchip believes that its family of products is secure when used in the intended manner, within
operating specifications, and under normal conditions.

+ Microchip values and aggressively protects its intellectual property rights. Attempts to breach the
code protection features of Microchip products are strictly prohibited and may violate the Digital
Millennium Copyright Act.

* Neither Microchip nor any other semiconductor manufacturer can guarantee the security of its
code. Code protection does not mean that we are guaranteeing the product is “unbreakable”.
Code protection is constantly evolving. Microchip is committed to continuously improving the
code protection features of our products.
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